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Introduction
Tap Forms is a very powerful organizational tool designed to help you keep track of all your life’s most
important information at home, at work, or on the go. With built-in support for Nearby and Cloud sync, now
you can keep all your Tap Forms data on your iPhone and iPad in sync with your Mac. So when you’re out
and about and you need to lookup some important piece of information, you can be confident to know that
you’ll have it right there with you.

Click here to watch the screencast videos for Tap Forms Mac 5.
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Forms, Fields and Records
A Tap Forms database contains Forms, Fields, and Records.

A Form is simply a template which contains a collection of fields that describe the data you wish to capture
and print.

A Field defines the type and title of the data that you want to store. For example, “First Name” is the title for
a field and it would probably have “Text” as the field’s type. Another field might be “Quantity” and it would
probably have the field type of “Number”. There are over 20 different field types to choose from.

A Record is an instance of a Form which contains the actual data values that you are recording. Each value
would be displayed in the fields you’ve added to your form. The title of the field would be displayed next to
the field value.

Tap Forms contains 33 built-in forms ready for you to use and customize. You can even delete them if you
don’t wish to keep them in your database. You can also create new forms from scratch which you customize
to capture exactly the kinds of data you want to keep track of.

Records Display

There are two different views for displaying your records.

1. Single Column List View
2. Multi-Column List View

To switch between each view, select the appropriate option under the View menu or click on one of the View
buttons in the toolbar.

Single Column List View

In single column list view, records are displayed in one column on the screen with each field in the form one
on top of the other. If you have a Photo field as the first field in your form template, Tap Forms will display a
thumbnail of the photo just to the left of the next set of fields.
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Multi-Column List View

In multi-column list view, Tap Forms displays your records in a table view with each column being a different
field in your form. You can scroll horizontally through the columns to view the contents of each field if they
do not all fit within the viewable area.
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There is also a small tools button ( ) just to the right of the table header in multi-column list view which
lets you decide which fields to display in the table. If a field is checked, it will display. If it’s unchecked, it will
be hidden.
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Section Headers and Index

Section headers within your records are used to separate one set of records from another. For example, if
you have a list of customers sorted alphabetically by last name, then Tap Forms will automatically generate
section headers with the first character of the last name. So all “Adams” will be in the “A” section and all
“Smiths” will be in the “S” section.

The section header title is determined by the first character of the First Sort Field. However, if you have a
Date field as your First Sort Field, Tap Forms will automatically group the records into Year and Month
sections. Another way to control the sectioning of records is to set the Group Records By sorting option.
Tap Forms will then display the full values for the selected field for the section titles. For example, in the My
Movie Library form, the records are grouped by Genre, so the records will be grouped together by Action &
Adventure, Comedy, Drama, etc.

On the iOS version of Tap Forms, you can easily jump to different sections in your records list by sliding
your finger up and down on the section index on the right of the records list view. On Mac OS X there’s no
such built-in control, so Tap Forms provides a popup button just to the right of the form name above the
records list view that will let you select which section you would like to jump to.
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When you click the above button you’ll see the popup list of sections.

You can hide the section headers if you don’t want them to appear in the list of records. This may be useful
if you have only a few records and you don’t want Tap Forms to take up the extra space to accommodate
the section headers.
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Using the Built-in Forms
1. Click on the My Forms popup button and switch from the My Forms item:

to the All Forms item:

You should now see a list of all the built-in forms that are available to you. You may need to expand the
categories to display the list of forms beneath each category heading. Note that if this is the first time you’re
using Tap Forms, most of your forms will have 0 records in them.
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2. Click on a form to select it.

There are currently no records in the selected form.
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3. Click the + button next to the form name in the second column to add a new
record to your selected form.

Fill in all the fields in your new record.
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Creating a New Form
1. Click the + button at the top-left of the window.

A new form will be created with a default field and the Form Inspector panel will display on the right of the
window.
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2. Select an icon for your form and give your form an appropriate name that
represents the content you will be storing.

You can set a variety of form level properties such as the Category your form will be located in, what the
First Sort Field, Second Sort Field, Third Sort Field, and Group Records By fields will be. You can choose
the sort direction too by clicking on the up or down arrows next to the sort field popup buttons.
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Calculation

If you have any Number, Rating, Checkmark, or Calculation fields in your form, you can use the Calculation
Field and Calculation Type to tell Tap Forms to compute the total, minimum, maximum, or average of the
field that you selected. The results will be displayed at the bottom of the single-column records list view.

Other

Single Column List View Fields is used to tell Tap Forms how many fields to display on the single-column
records list view. You can tell Tap Forms to display the first 1, 2, 3, 4, or 5 fields on the single-column
records list view. If the first field is a Photo field type, then up to 6 fields can be displayed because the
Photo field counts as one field but then you still have 5 additional fields you can display next to the Photo
field thumbnail.

Hide Form tells Tap Forms not to display the form on the “My Forms” list even if there are records within the
form. Normally the “My Forms” list will display forms that have 1 or more records within them. The form will
still be visible in the “All Forms” list. The “All Forms” list displays all forms no matter how many records are
in them.

3. Click the Fields tab and add some fields by clicking the + button below the
fields list.

Type in a title for your field and then select a field type.

As you add new fields, Tap Forms will display the properties inspector for each field type you add down
below. Here you can set different field properties such as the field name, field type, number formatter,
decimal places, default value, etc. Each field type has its own unique set of properties you can change.

You can also rearrange the order of fields by dragging them up and down in the fields list. By rearranging
the order of fields, Tap Forms will display them in whatever order you’ve set on the Default Layout and on
the Multi-column List View. You can also delete fields by clicking the delete button next to the add field
button. There is also a duplicate field button which will duplicate the selected field.

If you change a field type from one type to another, you may see a warning message
appear. Tap Forms will do its best to convert data from one type to another, but this is not
always possible. Be sure you want to do this or the data in the selected field will be
removed. For example, you can switch between Text, Note, Website, Email, but you can’t
switch between Number and Photo, etc. without the data in the field being removed.

!
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If you drag a Photo field to the first position in your form, Tap Forms will display the
thumbnail of the photo to the left of the next set of fields on the single-column list view. You
can control the size of the thumbnail on the Photo properties view.
*
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Field Types
Tap Forms has 23 different field types. Each field type has its own set of properties that can be set in order
to customize the way Tap Forms displays and edits your data.

The following table describes all the field types available in Tap Forms.

Icon Field Type Description

Text Text fields store small amounts of text. Normally a single line’s worth. For example, a
Movie Title.

Number
Number fields display numeric data. They can be configured to format the display as
currency, decimals, percentages, scientific notation, spell out (e.g. “twenty four ninety
nine”), or as a duration (e.g. “10 hrs, 3 mins” or “10:03”).

Date
Date fields will display the month, day, and year. The display format used depends on
your Region Format settings in the System Preferences. In general, Tap Forms uses
the Medium date format to display dates.

Time
Time fields will display the hours and minutes and AM or PM. This also depends on
your region settings. If you have 24 hour mode enabled then you won’t see AM or PM.
Tap Forms uses the Short time format to display times.

Date &
Time

Date & Time fields are a combination of the Date and the Time fields displayed in a
single field. The Date part will use the Medium date format. The Time part will use the
Short format. By adding a Date & Time field to your form, you can also enable the Alerts
function in Tap Forms. With the Alert function you can tell Tap Forms to notify you at the
specified date and time. You can also include a short note which will be displayed along
with the notification. Alerts can be scheduled to repeat at a variety of frequencies.
These options are available when you’re editing a date value in your record.

Date
Created

Tap Forms keeps track of the date a record was created. The Date Created field type
will expose this field to your forms. You can sort by this field or filter your records by this
field.

Date
Modified

Tap Forms also keeps track of the date and time a record was modified. You can sort
by this field or filter your records by this field. Please note however that if you change
the sorting of your form after your form is created, Tap Forms will update the Date
Modified value for each record to be the current date and time. So it’s best to set it once
and leave it.

Audio
Recording

Tap Forms for Mac can play back audio recordings made on Tap Forms for iOS, but it
cannot record audio notes on its own. When you sync, Tap Forms for Mac will gain
access to the audio notes you created on iOS.
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Calculation

The Calculation field type lets you construct formulas to compute mathematical
expressions. Formulas can contain references to other fields within your form. You can
use all the basic mathematical operators such as ( ) * / – + as well as the keyword
$now. The $now keyword will insert the current time into the formula before being
evaluated.

Checkmark

The Checkmark field lets you have a basic on/off switch for setting whether something
is true or false, on or off, yes or no, etc. Checkmark fields can be used in formulas also.
For example, if you wanted the total to be computed only when a checkmark field is on,
just drag the checkmark field into your formula and use multiplication to cause the result
to be either 0 if it’s off or whatever the regular result would be if the checkmark field
value is on.

Contact

The Contact field lets you reference a contact from your Mac’s Contacts database. Tap
Forms will copy the first and last names into its database as well as the Contact’s
unique identifier. This information will be used to look up the contact’s record from the
Contacts database whenever you click on the contact button to the right of the field.
Note: due to the way Apple syncs contacts across devices, the unique identifier could
get changed between devices. This can cause Tap Forms to display the wrong contact
when you click on the contact button to the right of the field.

Drawing The Drawing field type on Mac is a read-only field. You can create drawings on iOS and
view them on the Mac version. You cannot draw into a field on the Mac version.

Email

The Email field will give you a button to the right of the field which will launch Mail
whenever clicked and pass the email address entered into the field into the To: field of a
new email message. Separate email addresses with commas to address more than one
email address at a time.

File
Attachment

The File Attachment field will let you store one or more files associated with your record.
You can tell Tap Forms if your File Attachment field supports just one file or multiple
files by checking the Multi-File Enabled checkbox on the Field Properties screen.
When Multi-File Enabled is checked, you will see a list of files within your File
Attachment field. You can double-click on a file to launch the app which is responsible
for that field type. You can also choose to attach your file as a copy of the file or as an
alias of the file. When you attach a copy, Tap Forms will copy the file selected into the
database. When the database is synced, so will the attachments that were copied into
the database. So you will be able to access the same files on your iOS devices and
other Macs that are syncing the same database document. Aliases cannot be viewed on
other devices nor synced.

Link to
Form

This field lets you connect different forms together in a parent to child relationship. Use
One to Many if you don’t want or need to share the records from the linked form with
other forms or records. Use Many to Many if you’d like to be able to select from a list of
previously entered records from another form and link them to the parent record. Use
Join if you’d like Tap Forms to manage the relationship between your forms for you
based on fields that match between the parent and child forms. Enable the Show
Inverse Relationship option if you want to display the parent record on the child form
you’re linking to.
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Link from
Form

The Link from Form field will display the parent record that links to the child record. This
field should never be created on its own. It is automatically created for you from the Link
to Form field when you enable the Show Inverse Relationship option.

Location

The Location field type will display to you a map of your current location. You can
search for different locations and drag the pin around to change your location. You can
also edit the location name, but Tap Forms will first do an address lookup to fill in the
address that matches your current location.

Note
The Note field type allows you to enter in large amounts of text. Text can also be styled
using different fonts, sizes, and colours. The Mac version has the ability to add bulleted
lists, but these are not displayed on the iOS version of Tap Forms.

Phone
The Phone field will convert a set of digits into a formatted phone number taking into
consideration different region formats for phone numbers. The iPhone version will also
dial or text the number when the phone button is tapped.

Photo

The Photo field will let you select a photo from your hard drive or use the built-in camera
to take a photo. You can also drag and drop an image into the Photo field from your
hard drive. Once a photo has been attached to your Photo field, you can click on the
QuickLook button to view a larger version of the photo or click the trash can button to
delete it.

Rating

The Rating field will display up to 10 stars that you can click on in order to rate your
records. For example, if you were maintaining a movie library you could add the film’s
popularity rating to your record. Ratings can be used in calculations and also at the form
level. So you could display the average rating for all the movies in your library.

Section
Heading

The Section Heading field will help you to organize the fields within your form into
sections. This makes working with long forms much easier.

signature The Signature field type on Mac is a read-only field. You can create signatures on iOS
and view them on the Mac version.

Table

The Table field type is a simple way of creating a field that can hold multiple values,
displayed in a grid or tabular format. Table fields are similar in some ways to a form in
that it’s comprised of one or more fields itself. Bento had a similar field type called a
Simple List. You can also select a form to connect to a Table field which can be used to
copy fields from into your Table field. This also allows you to select records from the
connected form to copy into your Table field’s sub-records. Tap Forms will use the field
titles in the Table field to match the field titles in the connected form in order to
determine which values to copy from the selected records.

Website
The Website field lets you store an address to a website or even another application on
your own computer. When you click on the website button to the right of the field, Tap
Forms will launch your web browser and take you to the address specified.
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Calculations
Tap Forms has a special field type called Calculation.

For basic math, use the following operators:

Operator Symbol

Add +
Subtract -
Multiply *
Divide /
Logical AND &
Logical OR ~

The following mathematical expressions in the Calculation field formula editor are supported:

Single parameter functions:

ABS: absolute value, which can be used as ABS(X)
ATAN: ArcTangent function which can be used as ATAN(X)
CEIL: CEIL(-3.2) = 3, CEIL(3.2) = 4
COS: Cosinus function which can be used as COS(X), X is a real-type expression. COS returns the cosine
of the angle X in radians.
COSH: Cosinus Hyperbolic function which can be used as COSH(X)
COTAN: which can be used as COTAN(X)
EXP: which can be used as EXP(X)
FLOOR: FLOOR(-3.2) = -4, FLOOR(3.2) = 3
LN: natural log, which can be used as LN(X)

In Tap Forms 5.2, for international regions which use a comma for the decimal point, you
will need to now use a comma in all the numbers you use in your formulas. You will also
need to use a semi-colon character as the delimiter between parameters in function calls.
Tap Forms will do this for you when you choose a function, but you will have to go back and
edit old formulas to use the semi-colon delimiter between function parameters.

*
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LOG: 10 based log, which can be used as LOG(X)
NOW: inserts the current time in seconds since January 1, 1970 00:00:00 GMT
SIGN: SIGN(X) returns -1 if X<0; +1 if X>0, 0 if X=0; it can be used as SQR(X)
SIN: Sinus function which can be used as SIN(X), X is a real-type expression. Sin returns the sine of the
angle X in radians.
SINH: Sinus Hyperbolic function which can be used as SINH(X)
SQR: Square function which can be used as SQR(X)
SQRT: which can be used as SQRT(X)
TAN: which can be used as TAN(X)
TRUNC: Discards the fractional part of a number. e.g. TRUNC(-3.2) is -3, TRUNC(3.2) is 3.

Two parameter functions:

INTPOW: The INTPOW function raises Base to an integral power. INTPOW(2, 3) = 8. Note that result of
INTPOW(2, 3.4) = 8 as well.
POW: The Power function raises Base to any power. For fractional exponents or exponents greater than
MaxInt, Base must be greater than 0.
LOGN: The LogN function returns the log base N of X. Example: LOGN(10, 100) = 2
MIN: MIN(2, 3) is 2.
MAX: MAX(2, 3) is 3.
DATE: The DATE([Field], "yyyy-MM-dd") function formats a date in a human readable way. Please
see the Unicode Technical Standard #35 for pattern syntax and examples.
FORMAT: The FORMAT([Field], "#.00") function formats a number in a variety of ways and returns a
text representation of the number. Please see the Unicode Technical Standard #35 for pattern syntax and
examples.

Three parameter functions:

IF: The IF(b, case1, case2) function provides branching capability. If b is not 0, then it returns case1,
else it returns case2. Example: IF(HEIGHT, 3/HEIGHT, 3) will make sure 3/HEIGHT does not cause a
division by zero error.
IFEMPTY: The IFEMPTY([Field], case1, case2) function also provides branching capability. If
[Field] is empty, then it returns case1, else it returns case2.
IFNOTEMPTY: The IFNOTEMPTY([Field], case1, case2) function also provides branching capability.
If [Field] is NOT empty, then it returns case1, else it returns case2.
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No parameter functions:

NOW: NOW() inserts the current date and time in seconds into the formula.
TODAY: TODAY() inserts the current date in seconds into the formula. The time is 00:00:00.
RND: RND() function generates a random number (double value) between 0 and 1.

Multiple parameter functions:

AVG: AVG(2, 5, 3,...) returns the average of all the parameters. e.g. AVG is 3.5.
SUM: SUM(2,3,5,…) functions returns the sum of it’s arguments. There is no preset limit on the number of
parameters.
CONCAT: CONCAT("A", "B", "C",...) joins values together. It’s an alternative to the + function for
text concatenation.

Text Concatenation

In addition to the above mathematical expressions, Tap Forms also supports text concatenation. With this
feature, you can create Calculation fields which return a Text value instead of a Number value.

For example, you could create a Calculation field called Full Name (or whatever you want to call it) which
has the following formula:

First Name + “ “ + Last Name

As long as you set the Result Type property on the Formula Editor to Text, then Tap Forms will evaluate
the above formula and return the string with the First Name and Last Name fields joined together with a
space character in between. It’s especially useful for creating labels. You can keep your First Name and
Last Name fields as separate fields, but for printing labels, you would want them to be joined together into a
Full Name field to make your labels look nicer.

An example of joining the parts of a mailing address so it avoids blank lines if certain fields are empty:

First Name + “ “ + Last Name + “\r” +
IFNOTEMPTY ( Company, Company + “\r”, “” ) +
Address 1 + “\r” +
IFNOTEMPTY ( Address 2, Address 2 + “\r”, “” ) +
City + “, “ + Province + “ “ + Postal Code
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In the above example, the IFNOTEMPTY ( Company, Company + “\r”, “” ) part checks to see if the Company
field is not empty. If it has a value, it returns the value in the Company field and adds a linefeed character to
it. If it has no value, it simply returns nothing (an empty string).

The "\r" part inserts a new line into the result.
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Searching
Tap Forms can perform two kinds of searches.

1. Search across all text and number fields in a form by using a simple search term.
2. Create one or more Saved Searches which target specific fields for filtering your records.

For basic searches, just enter a search term into the Search field:

After you type in a search term, a bar will appear below the Search field with a Save button.

Click the Save button to save the search. Tap Forms will display the search beneath the form on the left
side of the window.

For more advanced searches, click the filter button to the left of the Search field. Tap Forms will display the
advanced search popover where you can add Search Rules which target your search to specific fields.
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Click the + button to the right of a Search Rule to add a new Search Rule.

Click the Save button to save your search.

Deleting a Saved Search

To delete a Saved Search, select your search, then right-click on it and select the Delete Search option. Or
select it and then select the Delete Search menu item from the Forms menu. Make sure the forms list on
the left is visible or you won’t be able to right-click on the Saved Search as it won’t be visible.

When you add multiple Search Rules, Tap Forms will combine each rule together to reduce
the number of records returned from the search. So the more Search Rules you add, the
fewer records will be returned. Click the All popup button and change it to Any if you’d like
to expand the search results list by adding more search rules.

*

You can also use an OR search between terms within the same value when using the
contains operator. For example Move Tile contains Terminator OR Hunger. You
would put just Terminator OR Hunger into the search term field to accomplish this. The
OR must be in uppercase.

*
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Sorting

To set a different sort order for a Saved Search than the default sort order set on your Form, with your
Saved Search selected, click on the Form button in the toolbar to display the Form Inspector Panel. Then
change the First, Second, Third, and Group Records By settings to how you would like your records sorted
just for that search. When you switch to a different search or to the main form itself, Tap Forms will switch
the sorting to reflect the settings for those items.
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Migrate from Previous Version
To migrate your current database, you must first create a backup file using the previous version of Tap
Forms. You can migrate a database from the Mac or iOS versions of Tap Forms.

To make a backup of your Tap Forms for Mac version 3.5x database:

1. From the File menu, click Backup.
2. Confirm where the file will be placed.
3. Click Backup.

The backup file will automatically be given a name using the format: Tap Forms[-computer name-
date].zip.

To migrate the database to the new version of Tap Forms:

1. Open Tap Forms version 5.0.

You only need to migrate your database on one device. Then use the Send Document
function to transfer that migrated document over to your other devices. If you do not do this,
you will not be able to sync that document between your devices.

!
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2. Click Migrate from previous version.
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3. On the Migrate Backup File screen:

a. Click Choose and select the backup file from the pop-up list.
b. A document name will be generated based on the backup file name. For example: Lee’s Mac

mini. You can change this to whatever you like.
c. If your database is encrypted or you have any encrypted fields in any of your forms, enter the

encryption key you were using. You can encrypt your database again after the migration if you
so desire.
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4. Click Migrate. The new database will be listed under Database Documents.

Once your database has been migrated, double-click on the database file to open it up. Everything should
be as it was before in the previous version of Tap Forms.
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Sending to Another Device
Documents to be synchronized to another device must be identical. Therefore, you must migrate the
database on one device only and then send that migrated document to your other device(s). Then set up
synchronization between the various devices. Documents can be sent between Macs and iOS devices.

To send a document to another device:

1. Ensure your devices are compatible with Apple’s AirDrop system.
2. Make sure the devices are within Wi-Fi range of each other and are connected to the same WiFi

network.
3. Launch Tap Forms for Mac, if not already open.
4. Launch Tap Forms for iOS, if not already open.
5. Close any document you might have open currently on any iOS devices you want to send to.
6. Close the document on the Mac that you want to send. Otherwise the Share button will be disabled.
7. On the Database Documents window, select a document from the list of files.
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8. Click the Share button at the bottom of the window.
9. Your Mac will display the AirDrop share window with your devices listed.

10. Click on the the device name you want to send the document to.
11. Your document will be transferred to your other device. If you’re sending to another Mac, AirDrop will

put the document into the other Mac’s Download’s folder. You’ll need to drag it in to the main
Database Documents window to have it appear there with your other documents.

Sending from an iOS device:
To send from an iOS device to another device, do the following:

1. Close any open documents in Tap Forms.

If you don’t see your iOS devices, make sure that AirDrop in the General > AirDrop settings
screen is set to Contacts Only or Everyone. If it’s set to Receiving Off, you won’t see your
device listed. If you’re transferring to your Mac and you don’t see your Mac appear on the
share sheet, go to the Go menu in the Finder, select AirDrop, then click on the Allow me to
be discovered by: text. That’ll display an option to select No one, Contacts only, or
Everyone. Choose Contacts only or Everyone.

*
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2. Tap on the action menu button at the top-left of the navigation bar

3. Tap on the Send Document function
!{IMAGE-LINK+Tap Forms-ios-send-doc}!

4. Tap on the document you want to send to the other device.
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5. You should see the share sheet appear.

6. Tap on the device you would like to send the document to under the AirDrop section. Ignore the other
items or other apps.

If you don’t see your device at the top of the share sheet, make sure that it’s turned on. In
the example screenshot above, my MacBook Pro is on showing my contact card photo.
That’s what you tap on to send to that device. Your’s will have a different name and icon of
course.

*
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7. AirDrop will transfer the document to iOS device and it will appear there on the main Documents view.
If you’re sending to a Mac, AirDrop will put the document into the Download’s folder. You’ll need to
drag it in to the main Database Documents window to have it appear there with your other documents.

iTunes File Sharing
if you cannot use AirDrop on your devices, you can alternatively use iTunes File Sharing to send a file from
your Mac to your iOS device or from your iOS device to your Mac.

1. Launch iTunes and plug your device into your Mac.
2. Click on your device in iTunes.
3. Find the iTunes File Sharing area. In the latest 12.7.x version of iTunes there’s a separate File

Sharing area. But on older versions of iTunes you have to navigate into the Apps area and then scroll
all the way down until you see the File Sharing area.

4. Scroll down to find Tap Forms in the list of apps and click on it.
5. You will see the Tap Forms Documents area appear on the right.

6. Drag a .tapforms document file from your Mac into the Tap Forms Documents area on the right in
iTunes.
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7. Or if you’re wanting to copy from an iOS device to your Mac, drag the file from iTunes to your Mac.

Now that you have the same document on each device, you may now proceed to setting up either Nearby or
Cloud syncing.

If you select a file in iTunes, pressing the Delete key on your Mac’s keyboard will delete it
from your iOS device.*
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iCloud Sync
Tap Forms 5.1 now support syncing your database documents via Apple’s iCloud servers.

Before you can sync with iCloud, you must:

1. be logged into your iCloud account.
2. have iCloud Drive enabled.

To setup iCloud sync:

1. Create a new document or open an existing one.
2. Click Preferences under the Tap Forms Mac menu.
3. Click Sync.
4. Select iCloud from the list of sync services.
5. Click the Enable iCloud Sync button

Tap Forms will then upload the forms and records in your document to iCloud. You should see messages
appear at the bottom of the window indicating when Tap Forms is sending and receiving. Tap Forms will
also generate an empty document placeholder on your other devices that are connected to the same iCloud
account. You’ll see a cloud icon with a down arrow in it.

Wait for Tap Forms to finish uploading to iCloud before you proceed.

When you open the placeholder document on your other device, After a few moments, Tap Forms will
download from iCloud and all your data for that document will be synced. This means that for iCloud you
generally don’t have to send a copy of your document over to your other devices before setting up sync
because that will happen automatically now.

There is also a Delete from iCloud button. This button allows you to delete the contents of the document
from your iCloud account, helping to free up your iCloud storage space should you no longer wish to sync
that document anymore. Deleting the document from iCloud will not delete it from your local drive. It can be

If you don’t see the placeholder document appear on your other devices, try rebooting your
device. Occasionally the notifications that iCloud sends don’t get delivered to Tap Forms so
it doesn’t know about the new document. Rebooting seems to help this.
*
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handy occasionally to delete the document from iCloud and then re-enable sync to have Tap Forms re-
upload the entire document.

When Tap Forms is downloading data from iCloud, it does so in batches of 200 items. It
repeats this over and over again until it’s done. Please let it finish. The first sync usually
takes the longest and it depends on how much data you’re syncing.
*

If iCloud doesn’t automatically update on your iOS device when a change is made on
another device, go to Settings > General > Background App Refresh and make
sure that Tap Forms is enabled for Background App Refresh.
*
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Nearby Sync
You can use either Wi-Fi (nearby) or the Cloud to synchronize. For instructions on syncing over the cloud,
see the Cloud Sync topic.

To configure synchronization with nearby devices via Wi-Fi:

1. Open the same database document on each device you want to sync with.
2. Under the Tap Forms menu, select Preferences.
3. Click Sync.
4. Click Nearby.
5. If the device isn’t listed, click the plus button.
6. Select the device.
7. Click Done.

Do the same on all of your devices so that Tap Forms on each device is connected to each other.
You will need to do this with every database document that you want to sync with each of your other
devices.

It’s ok to have some devices syncing one document and other devices syncing other documents. For
example, you may want to sync your private information with just your devices, but sync your shared
information with a family member or co-worker with one or more of their devices.

Before you can sync, you must have a copy of the same document open on each of your
devices. Use the Send Document function to transfer a copy of your document from one
device to another. On Mac click on the Share button at the bottom of the main Documents
window. On iOS, tap on the share button at the top of the main Documents view and select
“Send Document”. Once you have the same document open on each device, then you can
setup sync between them. Tap Forms must be running on each device and have the main
Documents view visible in order for the transfer to take place. See the Sharing with Another
Device topic for more information.

*

Each device must be on and have the same database document open at the same time in
order for Nearby sync to function. The moment you make a change on one device is when
synchronization will begin on all your devices.
*
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If a device doesn’t show up, check the length of your device names. They should be no
more than 25 characters or os. For example, if my device was called “Brendan Duddridge’s
iPhone 6 Plus”, that would be 33 characters. This will cause the device not to show up in
the list even if it has the same document open. This is due to a networking issue where
devices on the network can’t have names longer than 63 characters. But Tap Forms
prefixes the device name with the document ID which is already 35 characters, plus an @
character.

*
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IBM Cloud Sync

For instructions on syncing with nearby devices over Wi-Fi, see the Nearby Sync topic. For instructions on
syncing with iCloud, see the iCloud Sync chapter. For instructions on setting up your own Apache CouchDB
sync server, see Apache CouchDB Sync.

IBM Cloud syncing is very useful if you want to sync with someone who does not share the same Apple ID
as you on their devices.

Here are the steps you need to do to create an IBM Cloud account and to add Cloudant as a service into
your account. You’ll need to do this first before you setup Tap Forms with your username and password
given to you by IBM Cloud now.

IBM has recently updated their Cloudant service to require customers to create a new IBM
Cloud account. If you already have an old Cloudant account, you must create a new
account on the new IBM Cloud service, and then set up the sync again, using the new
service.

!

Also please note that IBM has implemented a 1 Megabyte request size limit for syncing with
their service. This means if you have photos and file attachments in your records that add
up to more than 1 MB, IBM will respond with a “the request entity is too large” error
during syncing. Tap Forms for Mac will display the record which causes the error to happen
so you can take appropriate action to remove the image or attachment so the record is
smaller than 1 MB. Please contact support@cloudant.com if you receive this error message.
Perhaps if enough people do, they may decide to increase the limit. If this becomes a
problem for you, you will need to switch to iCloud, Nearby, or Apache CouchDB syncing
instead.

*

Before you can sync, you must have a copy of the same document open on each of your
devices. Use the Send Document function to transfer a copy of your document from one
device to another. On Mac click on the Share button at the bottom of the main Documents
window. On iOS, tap on the share button at the top of the main Documents view and select
“Send Document”. Once you have the same document open on each device, then you can
setup sync between them. Tap Forms must be running on each device and have the main
Documents view visible in order for the transfer to take place. See the Sharing with Another
Device topic for more information.

*
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Visit https://console.bluemix.net/catalog/services/cloudant-nosql-db to create your account.

1. Scroll down to Pricing Plans.
2. Select a pricing plan. Try the free Lite service first to see if that works for you. If your storage

requirements are higher than 1 GB, then you may need to select the Standard plan, but there will be a
fee for that. If you’re not comfortable with that, then you can certainly use one of the other built-in
sync solutions in Tap Forms.

3. Click on the blue Sign Up to Create button on the right.
4. In the Email field, enter your email address, and then press the tab key.
5. Enter your remaining details including a password that you will use to login to your IBM account on

their website. You will not be asked to type your password in again. Please remember it. Also please
note this is NOT the same password you use to Sign In to Cloudant within Tap Forms. That will be
issued to you later on.

6. Click the Create Account button. You will be asked to check your email to verify your email
address.

7. Look for an email in your email account titled: Action required: Confirm your IBM Cloud
account.

8. Click the blue Confirm Account button.
9. You should see a Success! screen.

10. Click the Login button to proceed.
11. Enter your login email address and password when prompted.
12. View the welcome splash screen and click the Next button or click the X button to close it.
13. You should see the Cloudant NoSQL page.
14. Click the blue Create button at the bottom-right of the web page.
15. Click Service credentials on the left where it says Manage, Service Credentials, Plan and

Connections.
16. Click the blue New Credential button on the right.
17. Accept the default name and then click the blue Add button.
18. Click the dropdown arrow next to View Credentials and copy the username and password

values. These are the user name and password values you will need to enter into Tap Forms in the
next step. For example, a username is similar to this: username:
7891234-qll3-lk92-woiu4-da0d345tg7b5-bluemix.

19. Now click Manage at the top-left side of the page.
20. Click the Launch button if you wish to view your Cloudant dashboard. This is where you can see your

databases that you’re syncing with Tap Forms once you’ve signed in to your IBM Cloud account within
Tap Forms.

Once you have your own IBM Cloud Cloudant service setup, you need to return to Tap Forms and then:

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 42 of 112

https://console.bluemix.net/catalog/services/cloudant-nosql-db


1. Open the database document you would like to sync.
2. Under the Tap Forms menu, select Preferences. On iOS, go to the Tools area then tap on Sync

Settings.
3. Click Sync.
4. Click Cloudant.
5. Copy the username value given to you from the Service Credentials in your IBM Cloud account.
6. Paste the username value given to you into the Tap Forms Username field. When you paste in your

username, the server address will automatically be entered for you.
7. Copy the password value given to you from the Service Credentials in your IBM Cloud account

and paste it into the Password field in Tap Forms.
8. Enable Auto-Sync if you wish to have Tap Forms sync your data automatically.
9. Click the Sign In button when you’re done.

Auto-Sync

If you enable Auto-Sync, Tap Forms will sync with Cloudant automatically whenever you make changes.
Any other device which is also running Tap Forms at that time will receive any changes you’ve made a few
moments later. If no other devices are running Tap Forms at that moment, the next time you launch Tap
Forms on those other devices, they will check Cloudant for any changes and will sync. If they have changes
that have not yet been synced to Cloudant, those changes will also be automatically synced.

If you’re not using Auto-Sync, select the Sync Now command from the File menu whenever you want to
sync your document.

Database Sharing

Cloudant has the ability to let you share a database with another Cloudant user. Tap Forms supports this via
the Shared by user setting on the cloud Sync Settings screen. Once you’ve setup database sharing and
granted the other Cloudant user access to your database, the other user will need to enter your username
into the Shared by user setting in Tap Forms. They also need to enter their own username and password
into the appropriate fields. Once they’ve done this, any changes they make to their copy of the database will
be synced with your copy of the database and vice versa.

Auto-Sync is a great way to make sure you are always accessing the current data
regardless of the device. However, this function may not be suitable for multi-user
synchronization, as all users will be interrupted briefly while Tap Forms synchronizes the
changes.

*
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Please note: Tap Zapp Software Inc. has no access to your data. Your data is stored and
managed solely by IBM Cloudant. Please see IBM’s Privacy Policy here:
http://www.ibm.com/privacy/details/us/en/
*
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Apache CouchDB Sync

What is Apache CouchDB?
Apache CouchDB is a free, open-source database server which employs the same Couch Replication
Protocol that Tap Forms uses to sync with IBM Cloudant. This means that Tap Forms is able to sync with
your own server hosted in your own home or office without incurring the expense of an outside cloud based
sync service.

Where can I get CouchDB?
Apache CouchDB can be downloaded from the following location:

http://couchdb.apache.org

Installing CouchDB
This topic will guide you through installing and setting up Apache CouchDB on a Macintosh. For other
platforms, see the Apache CouchDB website for help.

1. On the Apache CouchDB website, click the Download button at the top of the page.
2. Click on the button to download CouchDB 2.1.1 for Mac OS X (10.6+). It’s important to download the

2.1.1 version.
3. In the Finder, double-click on the Apache-CouchDB-2.1.1.zip file to uncompress it.
4. Drag the Apache CouchDB.app file into your Applications folder.

This is an advanced topic which describes how to install and setup your own CouchDB
server. Running your own CouchDB server will allow you to have your own sync solution
within your own network without incurring the limitations of Nearby sync. You won’t have to
have the same document opened at the same time for sync to function. All changes made
on all your devices will be stored in your Apache CouchDB server. The primary audience for
this sync solution is anyone who doesn’t want their data to be stored on a server outside
their home or office location.

!
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Setup
1. Run the Apache CouchDB application.
2. Open up the CouchDB admin web page. It should launch your web browser and take you to the admin

page automatically. You may recognize it because it looks very similar to the IBM Cloudant
Dashboard. If it doesn’t launch, you can select Open Admin Console from the CouchDB menu that
will display in your menubar.

3. Verify the install by clicking on Verify, then Verify Installation. You should see checkmarks next to
each entry.

4. Click on Admin Party! then create an admin account.
5. Click the Create Admins button to do that. Then give the admin a username and password.
6. Click the Save button when done.

To create non-admin regular users
It’s not as straight forward to create a regular user with CouchDB. I don’t know why they don’t have a proper
interface for creating regular users. But it’s simple enough when you know how.

1. Click on the Databases button in the CouchDB admin page.
2. Click on the _users database. If the _users database does not exist yet, make sure you went

through the Setup process first.
3. Click the (+) button and then select the New doc function. A new record will be created in the _users

table for you with a default value.
4. Remove the default value.
5. Copy and paste in the following code (including the curly braces) into the record.

If you see an entry for bind address, make sure it’s set to 0.0.0.0 or else you won’t be able
to connect to it from other devices.*
Only admins can create databases. Because only admins can create databases, if you try to
sign-in with a regular user account and the database hasn’t been created in CouchDB yet,
Tap Forms will display an error indicating the database does not exist. You can temporarily
sign-in as an admin to create the database or you can use the CouchDB admin console to
create a database with a matching the ID number you see on the Sync Settings screen in
Tap Forms. You’ll know it when you see it since it starts with “db-” and has a bunch of
random letters and numbers after it. Copy that to the clipboard and paste it into the
CouchDB admin console when creating your database.

*
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6. Replace username in both spots with the username you want to create. Don’t use any special
characters in the username. Just letters and numbers. No spaces or punctuation.

7. Replace plaintext_password with a proper password.

{
"_id": "org.couchdb.user:username",
"name": "username",
"type": "user",
"roles": [],
"password": "plaintext_password"

}

8. Click the Create Document button when you’re done. The password will automatically be encoded
into a more secure derived_key and salt format when the document is created. This means
anyone looking at the _users database will not be able to tell what the password is. So you’ll need to
remember what it was.

Configure CouchDB for Single Node Setup
CouchDB 2.0 can be used in a single-node and cluster setup configuration. A single-node CouchDB 2.0
installation is what most users will be using. For more advanced setups, consult the online documentation at
http://docs.couchdb.org/en/2.0.0/contents.html.

1. Click the Setup button. You will be asked to set up CouchDB as a single-node instance or set up a
cluster.

2. Click the Single-Node-Setup button. You will be asked for an admin username and password.
Choose them well and remember them. You can also bind CouchDB to a public port, so it is
accessible within your LAN or to the public.

Once you’ve done this you will be able to connect to your new CouchDB server from within Tap Forms
running on other devices.

Setup Tap Forms 5 for Mac
1. Launch Tap Forms and open the document you want to sync.
2. Click Preferences under the Tap Forms menu.
3. Click the Sync tab.
4. Click the Cloudant & CouchDB button.
5. Click the Service Provider popup button and choose Apache CouchDB.
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6. Enter the IP address of your CouchDB server in this format: http://127.0.0.1:5984. If you’re
running your server on the same computer that Tap Forms is running on, use the IP address
127.0.0.1. Don’t forget to add a : followed by the port number 5984 after the IP address. If your
CouchDB database is on a different server, then use that server’s IP address instead.

7. Click on the Auto-Sync checkbox to enable automatic syncing.
8. Click the Sign In button to sign-in to your new CouchDB server. The sync process will now begin.

Setup Tap Forms 5 for iOS (for local area network syncing
only)

1. Launch Tap Forms on your iOS device and open the document you want to sync.
2. Tap the Tools tab.
3. Tap the Sync Settings function.
4. Tap the far right Cloud button.
5. Tap CouchDB next to the Cloud Service option.
6. Tap the Server field and enter the IP address of your CouchDB server in this format:

http://0.0.0.0:5984. Replace the 0.0.0.0 with the actual IP address of your own CouchDB
server. Don’t forget to add a : followed by the port number 5984 after the IP address.

7. Tap Auto-Sync to enable the Auto-Sync function.
8. Tap the Sign In button to sign-in to your database. The sync process will now begin.

Your Mac and iOS devices should now be syncing to your CouchDB server. There’s nothing more you need
to do.

You will need to use http instead of https if you’re connecting to an IP address. If you
would prefer to connect to a named server, for example
https://couchdb.mycompany.com:6984 then you’ll need to make sure you use https
and you have the appropriate SSL secure certificate installed on that server. The default
port number for https connections is 6984. By using an IP address instead of a named
server, you can avoid needing to setup an SSL certificate. However, syncing between Tap
Forms and your CouchDB server will NOT be secure. It’s preferable to setup the
appropriate SSL certificates on your CouchDB server so you can sync securely.

!
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Optional, but highly recommended: Configure CouchDB to
accept SSL secure connections
Configuring CouchDB to use SSL connections is more complicated. See the following page in the CouchDB
documentation for more information:

How Do I Configure SSL (HTTPS) in CouchDB?

If you’re running your own CouchDB server on your own network or even on the same Mac you run Tap
Forms on, then you can generate a Self Signed SSL Certificate to enable secure connections to the
CouchDB server. However, to be truly secure you should obtain an SSL certificate from a valid Certificate
Authority.

Here’s how you generate a Self Signed Certificate:

1. Launch the Terminal application
2. Generate a private key by copying and pasting the following line into the Terminal application window.

Press the Return key after every line you copy and paste.

openssl genrsa -out couchdb.key 2048

3. Generate a certificate signing request

openssl req -new -key couchdb.key -out couchdb.csr

4. After the above command is entered, your Mac will ask you a series of questions. Here’s an example:

You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----
Country Name (2 letter code) [AU]: CA
State or Province Name (full name) [Some-State]: Alberta
Locality Name (e.g., city) []: Calgary
Organization Name (e.g., company) [Internet Widgits Pty Ltd]: Tap Zapp Software
Inc.
Organizational Unit Name (eg, section) []:
Common Name (e.g. server FQDN or YOUR name) []: voyager.local
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Email Address []:
Please enter the following 'extra' attributes
to be sent with your certificate request
A challenge password []:
An optional company name []:

The most important part of the above questions is the Common Name value. Since my computer is called
Voyager, I put in voyager.local for the Common Name setting. You can find out what your computer
name is by launching the System Preferences application and clicking on the Sharing preferences
panel button. The value you’re looking for is right beneath the Computer Name setting where it says
Computers on your local network can access your computer at: Voyager.local

5. Create the self signed certificate

openssl x509 -req -sha256 -days 1095 -in couchdb.csr -signkey couchdb.key -out
couchdb.crt

6. Copy the couchdb.key and couchdb.crt files to a location where CouchDB can find them.

Configure settings in CouchDB

1. Back in the CouchDB admin webpage (Fauxton) on your computer, click the Configuration button.
2. Click the Add Option button.
3. Enter in the following options:

Section ssl

Name cert_file

Value /Path/to/couchdb.crt

Section ssl

Name key_file

Value /Path/to/couchdb.key

I found that when following the above instructions, I had to add a couple of more settings to prevent
CouchDB from failing to startup after I edited the configuration.

Section ssl

Name ciphers

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 50 of 112



Value undefined

Section ssl

Name secure_renegotiate

Value undefined

Section ssl

Name tls_versions

Value undefined

Optional settings to protect access to some basic functions that return information about your
CouchDB installation, such as the list of database names.

Section chttpd

Name require_valid_user

Value true

Section couch_httpd_auth

Name require_valid_user

Value true

There may be more appropriate values, but this worked for me.

The last setting must be added inside the following file (for CouchDB 2.1.1):

/Users/[your username]/Library/Preferences/couchdb2-local.ini

[daemons]
httpsd = {chttpd, start_link, [https]}

You will not be able to logout of the admin console when you add the above setting because
your browser will log you in again if it remembers the username and password.

!
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Once you’ve got your SSL certificate and key all setup and configured, you can use the name of your
machine instead of the IP address inside Tap Forms. For the above example, I would use
https://voyager.local:6984 to connect because Voyager is the name of my MacBook Pro.

To connect from iOS to your CouchDB server over SSL
Before you can connect to your CouchDB server using the name of your server (e.g.
https://voyager.local:6984), you must first install the couchdb.crt file on your iOS device.

To install the SSL certificate on your iOS devices:

1. Email the couchdb.crt file from your Mac to your iOS devices.
2. Tap on it in the Apple Mail app.
3. The Settings app will launch and you will be taken to the Install Profile screen.
4. Follow all the prompts to install the certificate on your device. There’s lots of taps. You may be asked

to enter your device password at some point.
5. Go to Settings > General > About > Certificate Trust Settings.
6. Tap on Enable Full Trust For Root Certificates to enable it for your certificate.

The certificate will show up in the Settings app under General > Profiles. You may have other
profiles there, but the one for your CouchDB server that’s using a self signed SSL certificate will have the
name of your server. In my case that’s voyager.local.

Now you can use https://voyager.local:6984 for the server name on the Apache CouchDB sync
settings screen in Tap Forms 5. Use your own server name of course.

If CouchDB gets stuck trying to launch over and over again, you can find the configuration
file in this location on your drive and delete it:
/Users/[your username]/Library/Preferences/couchdb2-local.ini
You will need to quit CouchDB first before you delete that file. Click the CouchDB menu in
the menubar and select the Quit Apache CouchDB command.

*

Please note that to connect to a CouchDB over SSL, you need to use port number 6984.
Although you can actually change that in the configuration in the CouchDB admin interface.*
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To connect from another Mac to your CouchDB server using
SSL

1. Copy the couchdb.crt file to all your Macs.
2. Double-click on the couchdb.crt file in the Finder. It will launch The Keychain Access application

and install it there for you.
3. Double-click on your certificate in the Keychain Access application. A window with the certificate

information will appear.
4. Click on the triangle at the top to expand the Trust section.
5. Select the Always Trust option next to When using this certificate.

To connect to your CouchDB server from the Internet
The above instructions help you to install and connect to a CouchDB server running on a Mac in your local
network. If you want to be able to connect to your CouchDB server from the Internet, you’ll need to do a few
things.

1. Open a hole in your firewall to allow traffic on port 6984 to be routed to your Mac running Apache
CouchDB. How you do this will vary depending on what kind of Internet router you have.

2. Create a new SSL Certificate so it uses a fully qualified domain name. E.g.
couchdb.yourcompany.com. You can either generate another self signed certificate or purchase an
SSL certificate from a trusted authority, such as GoDaddy.

3. Configure a DNS service to resolve couchdb.yourcompany.com to the IP address of your network. If
you have a dynamic IP address provided by your ISP, you can use a free service like
http://freeddns.noip.com

4. Configure Tap Forms to connect to https://couchdb.yourcompany.com:6984 (use whatever
DNS name you’ve given your server).

If you want to use the same server address when connecting to CouchDB on both the inside
and outside of your local area network, you’ll need to configure a DNS server on your local
network to return the local IP address of your CouchDB server (e.g. 192.168.0.5). This is
very useful if you use MacBooks and iOS devices both inside and outside of your local area
network. Your Macs and iOS devices will also have to be configured to use your local
network’s DNS servers.

!
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Categories
Categories are used to group forms together. Tap Forms ships with a few built-in categories, but you are
free to modify them, delete them, or create your own.

To manage your categories:

1. Click on the Tap Forms menu
2. Click on the Preferences menu item
3. Click on the Lists button.

You can drag the categories up and down to rearrange them. The list of forms on the left side of the main
window will update when you rearrange your categories.

Double-click on a category name to edit the name.

Click the + button to add a new category.

Click the – button to delete the selected category.

If you delete a category, all forms which belong to that category are moved into the
Uncategorized category. You cannot delete the Uncategorized category.*
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Pick Lists
Pick Lists are convenient lists of values that you can use on any Text or Number field in any form. You can
even share the same Pick Lists between different forms and fields. You can create single select, multi-
select, combo boxes, or popup button Pick Lists. They all show the same information but multi-select Pick
Lists allow you to select more than one value at a time. Single select, combo box, and popup button Pick
Lists allow you to select only a single value at a time.

To manage your Pick Lists:

1. Click on the Tap Forms menu.
2. Click on the Preferences menu item.
3. Click on the Lists button.
4. Click on the Pick Lists button.

To add a new Pick List, click the + button at the bottom-left of the Edit Pick Lists screen.

There are 4 different styles of Pick Lists under the “Display As” column heading.

1. Single Value Popover – This is the default style where Tap Forms will display a popover view that
allows you to select a single value.

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 55 of 112



2. Multi-Value Popover – A multi-value pick list will allow you to select more than one value to assign to
a field.

3. Combo Box – This gives you a popup button that also has a type-ahead text field as part of it. So you
can type a value and Tap Forms will fill in the rest or you can click the arrow (or press the down arrow
key on your keyboard) to display a list of possible values.

4. Popup Button – This gives you a popup button that contains the list of values available. You can
select a single value from the popup button.

Use values from list:

To add a new value to the selected Pick List, click the + button beneath the values list.

If you have lots of values to add to a Pick List, it would be much quicker to click the Add Values… button
and type your new values into the popover that is displayed. You can even paste values into the popover if
you already have a list of values on your clipboard.

Use values from field:

You can also choose to get the values for your Pick List from another form’s field. To do that, click on the
Use values from field radio button, then select a Form and a Field.
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Whenever you add records to the selected form and put values into the selected field, they will become
available to you in this type of Pick List.

To associate a Pick List with a field:

1. Click the form you want to edit.
2. Click the Form button in the toolbar.
3. Click the Fields tab.
4. Click the field that you’d like to assign the Pick List to.
5. Scroll to the bottom of the properties for the selected field and click the Pick List popup button.
6. Select the Pick List from the popup button.

You will now see the pick list button appear next to the field in the Default Layout, your custom layouts, and
the multi-column list view.
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Layout Designer
The new layout designer makes creating beautiful layouts as easy as dragging and dropping.

To create your first layout, click the + button beside Default Layout

The Layout Inspector panel will automatically display on the right when you add a new layout. But you can
also display and hide the Layout Inspector Panel by clicking the Layout button in the toolbar at the top of the
window:
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The Layout Inspector provides you with tools to customize the layout of your form’s fields and other graphic
elements you might like to have on the page.

The Layout Name property allows you to set the name you’d like to give to your custom layout. The tab
button that represents your layout will display this name. Clicking on that tab will switch to the selected
layout. You can have as many layouts as you would like.

The Design For property allows you to select the purpose for the layout. You have three choices:

1. Screen lets you design a layout which will resize itself to fit the screen the layout is being displayed
on. This is perfect for data entry layouts.

2. Printer lets you customize the design of a single page print layout. This is perfect for designing
invoices, product marketing descriptions, mail merge letters, etc.
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3. Labels lets you create a label template by selecting from more than 1000 Avery® label templates.
You can also customize any of the built-in label templates or create your own from scratch.

The Printer property lets you select which printer you would like to print the layout to.

The Page Size property lets you select a paper size to print to. For example: Letter, Envelope, A4, etc.

The Orientation property lets you select from portrait or landscape. The page size on screen will resize
appropriately according to the Page Size and Orientation properties you select.

The buttons at the top of the Layout Design View let you select a Zoom Level, turn on and off the Text
Inspector, the Rulers, and the Snap to Grid functionality.

To the right at the top of the Layout Inspector panel are the layout design tools.

The Arrow tool lets you select, resize, and drag around the objects on your layout page.

The Line, Oval, and Rectangle tools allow you to draw lines, ovals and rectangles on the page. You can
constrain the line, oval or rectangle by holding down the shift key as you drag a handle around on the page.
You can change the stroke of a line, circle or rectangle to make it thicker or thinner. You can also change
the stroke colour of lines, ovals, and rectangles using the Graphic Properties Inspector which will appear
when you select an object. Ovals and rectangles can also have their fill colours changed.

The Text tool allows you to create blocks of text which will stay the same on every record. This would be
useful for things like company names, addresses, or any other kind of text that you want to remain the same
on every record.

Mail merge. If you enter a field name within square brackets in a static Text block, Tap
Forms will replace the field name and square brackets with the value from the field for that
record when you print your record. For example: “Dear [First Name], the amount owing on
your account is $ [Amount Owing] .”

*
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The Image tool allows you to create areas on the layout which will be filled with any image you have
available on your computer. These images will stay the same on every record. This would be good for things
like a company logo, icon, photo or any other kind of image you want to have on every record.

Layout Properties

The Layout Properites panel lets you change the layout name, what your’e designing your layout for (screen
or printer), set the printer, the page size, and the page orientation.

Fields and Layers

The Fields list shows all the fields that are available to be dragged into the layout area. Below the Fields list
is a checkbox which will tell Tap Forms to automatically create a label for you when you drag a field to the
layout area. Labels will be given the default value of the field name, but they can be changed after they
have been created. You can change label colours, fonts, sizes, and text alignment.

The Layers list shows all of the objects that are already on the page. You can drag these objects up and
down to send them behind or in front of other objects. You can also lock objects so they can’t be moved
around accidentally.

Text Inspector and Alignment Controls

The Text Inspector lets you set fonts, sizes, colours and text alignment (left, centre, right, or full). When the
Text Inspector is visible you also have access to controls for aligning objects on the layout area. You can
select multiple objects and align them all together using these controls.

Objects can have their left edges, right edges, bottom edges, and top edges aligned. They can also be
aligned vertically or horizontally. The Layout menu also gives you some further options for sizing all the
selected objects so they become the same width or height.

The Text Inspector can also be used when editing a record to set the text properties of a Note field. You can
highlight some text and change the font, the font size, make it bold, italicized, underlined, or adjust the text’s
alignment.

The Image tool is different than a Photo field in your form. A Photo field will change its
image with every record while the Image tool’s image will remain the same on every record.*
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To delete an object from your custom layout, just select it and press the Delete key on your
keyboard. This will only work when the layout inspector panel is visible so that you’re in
layout design mode. To delete the field completely from your form, click on the Form button
in the toolbar, then the Fields tab. Then click on the field you want gone forever, then press
the – button to delete it. If you do that before deleting the object from your layout, the object
on your layout will still be hanging around, but will be non-functional. So delete it from your
custom layout first and then delete the field itself.

*
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Labels
Tap Forms has a very powerful label design engine built-in. You can select from over 1000 Avery® label
templates, customize the built-in templates, or create your own from scratch.

Before you can select a label template, please create a new custom layout and choose the Labels option
next to the Design for property in the Layout Inspector panel on the right. Once you do that, you’ll see the
Select a Label button appear.

Please see the Layout Designer chapter for more information.

When you click the Select a Label button, the following popover view will appear:
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You can filter labels by paper size or you can enter in a keyword or Avery Product Code to help you find the
label type you’re looking for. Click the Select button when you’ve found the label template you’re looking for.

To customize the selected label or to create your own label from scratch, click on the Edit Label button.
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You can also choose to print the same label per page or you can select the Multiple records per page
option which will tell Tap Forms to print a different record on each label. Printing the same record for each
label would be very useful for printing something like a Business Card where you want the same information
printed on each card. Printing multiple records per page would be perfect for printing Address Labels where
you want a different address on each label.

After you’ve selected or edited your label format, it’s time to drag fields into the layout designer area and
customize the design of your label. To get a larger view of your labels, adjust the zoom level to be higher
than 100%.

If you don’t see the Multiple Records Per Page option, drag the horizontal divider bar on
the layout inspector panel down a little bit to reveal that option.*

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 65 of 112



To print your labels, select the Print function from the File menu and make sure you have
the Details (1 record per page) option selected. Note, if you have Multiple records per
page enabled for your label, you will still get multiple records per page printed, despite what
the Details option says.

*
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Bento Template Importer
Tap Forms for Mac includes a Bento Template Import command to help you migrate from Bento to Tap
Forms. Bento has been discontinued by FileMaker and is not fully compatible with OS X 10.10 Yosemite.

Tap Forms will import Bento 3.0 to 4.1 version templates. However, you will need version
4.0 or higher of Bento in order to be able to export your Bento data along with your
templates. One other caveat is that if you’re using a version of macOS higher than
Mavericks, you may experience an issue where Bento says “Upgrading Database” but never
completes the job if you’re upgrading from Bento 3. If this happens to you, you will need to
find an older version of macOS to perform your upgrade. Alternatively, send a Bento 3
backup file to support@tapforms.com and I’ll covert it for you. I have a copy of macOS
10.9.5 Mavericks funning inside a Parallels Desktop virtual machine that I use for this
process. If you need the 30 day trial version of Bento 4.1.2 in order to convert your data,
please email me.

!
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To import your Bento template in Tap Forms:

1. Launch Bento and select your library.
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2. Select Export… from the File menu and choose the Template option.

Make sure you click on each related library displayed in the “Include these related libraries” list if you want
Tap Forms to be able to join your related forms together. Also click on “Include records in template” if you
want Tap Forms be able to import your Bento data also.

If you don’t see the “Include records in template” option, then you’re not using the latest
version of Bento. You’ll need to download that first before proceeding. The link is at the top
of this page.

!

If you have any encrypted fields in Bento, you will need to change those in Bento first to
unencrypted Text fields before you export the template. The encrypted fields will not import
into Tap Forms.
*
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3. Save your template.

4. Launch Tap Forms, create a new empty document or open an existing
document you’re using, and select the “Import Bento Template” command from
the File menu and select your Bento template file.

Click the Choose button when you’ve found your Bento template.

If the Import Bento Template option is greyed out, please make sure you have a document
already opened and that document is in the foreground.*
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Tap Forms will now import your template and records.

If your template contains more than one related form, Tap Forms will automatically create a new category
for you and put your related forms together inside that category. The category will be given a name based
upon the file name of the template you are importing.

You will need to expand the category to view the forms by clicking on the triangle just to the left of the
category name.

Once you’ve imported your Bento template, you can click on any of the layouts that Tap
Forms generated from the Bento library. You may need to reposition some elements and/or
make some adjustments to the font sizes and styles. Also, the Date Created and Date
Modified fields are usually the first fields that get imported, so if you don’t want them there
you can just delete them in Tap Forms or move them down the list of fields in your form.
Otherwise they’ll be the first two fields which show up in the records list view. Most likely not
the desired result.

*
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Bento Fields in Tap Forms
The following table describes how Tap Forms imports Bento forms and fields. Field types not on this list are
not supported in Tap Forms.

Bento Tap Forms

Form A Bento form is converted to a Tap Forms layout. Once you’ve imported a Bento template, you
can further customize the layout in Tap Forms or add additional layouts to meet your needs.

Text

Bento text fields can be one or more lines long. Tap Forms has 2 different text field types.
• Text fields are used for shorter one-line bits of information, such as a Movie Title.
• Note fields are used for larger amounts of text, such as a Movie Synopsis.
• Tap Forms will convert Bento text fields into Text or Note fields depending on the height

of the field in the Bento form.
• Tall fields in Bento will be converted to Note fields in Tap Forms.
• Small fields in Bento will be converted to Text fields in Tap Forms.

Number Bento Number fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Decimals.

Currency

Bento Currency fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Currency and the Decimal Places is set to 2. Note: Tap Forms supports only the currency that
you have by default according to the system’s regional settings. For example, in Canada, all
currency values will be in CAD. In the UK, all currency values will be in GBP.

Counter Counter fields are converted to Number fields.

Duration Duration fields are converted to Number fields with the Number Formatter set to “hours, mins”.

Rating Rating fields are converted to Tap Forms Rating fields.

Dates and
Times

Times are converted to Time fields. Dates are converted to Date fields. If the Date field has the
flag to show the Time set, then it’s converted to a Tap Forms Date & Time field.

Media Media fields are converted to Photo fields. The photo file is also extracted and copied into the Tap
Forms Photos folder.

Checkbox Checkbox fields are converted to Checkmark fields.

Choice Choice fields are converted to Text fields. The values in the Choice field are converted to a Pick
List and associated with the Text field.

Calculation Calculation fields are converted to Calculation fields. Tap Forms makes a best guess at trying to
convert the Bento formula to a Tap Forms formula, but it’s not going to be very accurate since

Note: Tap Forms 5.2 now supports importing Bento’s Simple List field type.!
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Bento supports more calculation options than Tap Forms at this time. You will probably have to re-
do your calculation formulas after the migration.

Location Locations fields are converted to Location fields. The longitude and latitude values are also set as
the location name in Tap Forms.

Phone Phone number lists are converted to a Phone field in Tap Forms. Only the first phone number is
imported. All other phone numbers in the list are ignored.

Email Email lists are converted to an Email field in Tap Forms. Only the first email address is imported.
All other email addresses in the list are ignored.

URL URL fields are converted to a Website field. Only the first value is imported. All other URL values
are ignored.

Related
Records

Related Record fields are converted into Link to Form fields with the Many to Many Link Type set.
Tap Forms also re-establishes the relationship data between forms.

File List File List fields are converted to File Attachment fields with the Multi-File Enabled setting turned on.
Files are copied into the Tap Forms Attachments folder.

Simple List Simple List fields are converted to Table fields in Tap Forms. Table fields are available in version
5.2 and higher.

The Bento Template Importer will be improved over time as new features are added to Tap Forms which
match some of the features previously available in Bento.
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Import Records
Tap Forms provides a wide variety of options for importing data from other applications. You can import both
CSV text files and Excel XLSX worksheet files.

Before you can import a CSV file to Tap Forms you must export it from another app to a text file. The text
file can have a .csv (comma separated values), .txt (text), or .tsv (tab separated values) file extension.
These file types are all pretty much the same but contain slightly different column delimiters. Just make sure
whatever column delimiter you use in the file, you set Tap Forms to use the same column delimiter.

Importing XLSX files requires only that you have the first row in your Excel file be the names of the fields
you would like to be in your form. Tap Forms will also only import the first sheet of data from the XLSX file.
Make sure your data is structured as regular rows and columns. Tap Forms will not import any formatting
information from an Excel worksheet file. The benefit of an XLSX file is you don’t have to worry about things
like column delimiters, line endings, or file encodings.

Choose File
The first thing to do is click the Choose file button and then select a file you wish to import.

When you import a CSV file, Tap Forms uses the first row of your file as the field names to
create when you choose the New Form option. If you choose an existing form to import your
records into, you must make sure that the first row values match the field names exactly as
you have them named in your form. Otherwise Tap Forms will create a new field for every
value in the first row which does not match a field name in the form you’re importing into.

*

You should also make sure your field names are unique in the header row. Tap Forms uses
the names of the fields in the first row to match up with the fields created in your form.*
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File Encoding
It’s very important to set the file encoding setting correct for the file you’re trying to import. If you don’t set it
correctly, Tap Forms won’t be able to understand all the characters in the file you’re trying to import. This
will most likely manifest itself in Tap Forms importing fewer rows than are actually in the file. Another issue
that you might notice is strange garbage characters appearing instead of properly accented characters.

File encoding is just a way of describing to a computer which characters the data in the file
represents. When you open a text file we just see characters, words and sentences. But to
a computer, the file contains just a bunch of numbers all strung together. File encodings tell
a computer what characters to display on screen when it encounters different numbers in a

*
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Column Delimiter
Tap Forms supports the following set of column delimiters: comma, semi-
colon, tab, and pipe. Column delimiters help tell Tap Forms how to
distinguish one field’s value from the next. If you have a delimiter within
your data then you must put double-quotes around the value. For example
“Rolling Stones, The”. Because there is a comma in the value, the entire
value must be surrounded with double quotes. Mostly you never have to

worry about this sort of thing because programs like Excel and Numbers should automatically put double
quotes around any data that contains a column delimiter within it. Tap Forms does then automatically when
you export records.

Date Format
When you have a file that has dates in it, Tap Forms needs to be
told how to interpret the date values. Is it month, day, year, or day,
month, year? In order for Tap Forms to understand the date
values in your file, you must tell it what format your date columns
use. Tap Forms only understands date formats that are numeric
based. So if you have a date in your file like “Dec 10, 2013” then
you need to convert that to be “12/10/2013” or some other
variation on a numeric date format. As long as it follows one of the
formats displayed in the list of date formats in Tap Forms.

There are a couple Date & Time formats in the popup menu also. You can use these if your date has a
combined date & time value within it that has the date and time separated by the letter T. For example,
when Bento exports its Date & Time values it uses this format: yyyy-MM-dd’T‘HH:mm:ss

text file. For example, the character A is number 65, B is 66, and so on when using the
ASCII file encoding format. UTF-8 is the most sensible file encoding to use because it can
encode characters from any language on Earth. However, if you’re importing from a
Windows PC that exported a CSV file using Excel, you most likely want to use Windows
Latin 1. On the Mac you may need to use Mac OS Roman file encoding.
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Time Format
Time formats follow the same principal as date formats. Just make sure
your time format is set to be the same format as what is contained within
your CSV file.

Select a Form
You can either enter a name for a new form to be created, or if you already have a form that you’d like to
import your CSV file into, select it from the list of available forms. If you select New Form, Tap Forms will
create a new form for you using the field names from the first row of the CSV file.

Assign Field Types

It’s important to tell Tap Forms before you import a CSV file what the field types are that it is importing. This
helps Tap Forms to properly interpret the data being imported. If you don’t do this and you try to change
field types after then Tap Forms will appear to lose the values in the field for which you changed the type.
The data is not gone, it’s just stored in a different column in the database.

Record Navigator
Click the record navigator to flip through the records in your CSV file. This will
help you to determine if you have your file encoding, column delimiter, and your

date and time formats set correctly.

Click the Import button when you’re ready to start the import process.

Tap Forms stores text data in a different column than it stores dates, numbers, location, or
checkmark data. There are some fields which you can safely switch types. For example,
switching a Text field to a Note field is safe. Switching a Rating field to a Number field is
safe. But switching a Text field to a Date field is not safe.

*
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Export Records
Along with importing CSV files, Tap Forms can generate CSV files so you can use your Tap Forms data in
other applications.

To export your records, click the File menu and select Export Records…

The various options on the Export Records screen tell Tap Forms how to generate the file that you’ll import
into other applications.
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File Encodings

As in the Import Records function, you can tell Tap Forms to export your file in a
variety of file encodings. UTF-8 is generally the best encoding to use as it
supports encoding characters in all languages. It may depend on the program you
want to import your data into that dictates which file encoding you should use.
Check the other program to see what file encodings it supports.

Number Formats

Tap Forms can also export Number fields in a variety of different formats. For the
Currency format, Tap Forms will use your regional number format settings to
determine what currency symbol to use during the export. For example, in
Canada and the USA currency numbers will be exported like $29.99, but in
Europe the same value would be exported as 29.99 €.

Export Record ID

By enabling this option, you’re telling Tap Forms to export the values that uniquely identify each record in
your form. Tap Forms will add a column called form_record_id to your CSV file. If you import a file into Tap
Forms which has a form_record_id column, it will search for matching records and update their field values
rather than adding new records to your form.

Export Linked Records

With this option enabled, Tap Forms will generate separate files containing the records from any linked
forms. If you want to import these files into another copy of Tap Forms, make sure you import the parent
form’s CSV file first and then import the child records. That way Tap Forms will be able to join up all the
child records to the parent records.

Field Type Tags

By turning on Field Type Tags, you’re telling Tap Forms to generate a header row that contains a tag that
identifies the field’s type.

The following are the tags that Tap Forms will generate
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Tag Field Type

<text> Text

<number> Number

<date> Date

<time> Time

<date_time> Date & Time

<check_mark> Checkmark

<contact> Contact

<web_site> Website

<note> Note

<photo> Photo

<audio> Audio Recording

<phone> Phone Number

<rating> Rating

<location> Location

<email> Email Address

<calc> Calculation

<file> File Attachment

<form> Link to Form

<draw> Drawing

<section> Section Heading

<date_created> Date Created

<date_modified> Date Modified

For example, a CSV export file of a movie library form would look something like this:

Movie
Title<text> , Release

Year<number> , Synopsis<note> , I Watched
This<check_mark>

Terminator
2:
Judgement
Day

, 1991 ,

The cyborg who once tried to kill Sarah Connor is
dead, and another T-101 must now protect her
teenage son, John Connor, from an even more
powerful and advanced Terminator, the T-1000.

, 1
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Export Media

When you enable this flag, Tap Forms will generate a zip file that contains your records in CSV files and
also a folder within the zip file that contain all of the media referenced in your records. Each media type will
have a separate folder named with the name of the form being exported and the media type. For example
“My Work Expenses-Photos”, “My Work Expenses-Files”, etc.

At the moment, file attachment fields with the multiple files setting enabled won’t get
exported into the zip file. That feature is coming in a future update.

!
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Relationships
Tap Forms has the ability to link forms together to establish relationships between them. There are currently
three types of links:

1. One to Many
2. Many to Many
3. Join

To make it easier to identify what is being talked about in this section of the documentation, I’ll refer to the
main form as the parent form. Any form that the main form links to will be called the child form.

One to Many

The One to Many link type is useful in situations where the child form’s data is unique to the parent record
it’s linked to. That is, no two parent records should link to the exact same records from the child form. It’s
easiest to describe this situation using an example.

Keeping Track of Clients and Expenses

If you wanted to keep track of all the expenses you incur when working for a specific client, you wouldn’t
want those expenses to be linked to any other client than the one for whom you are currently working. A one
to many relationship is useful in this situation. One client has many unique expenses which are attributable
only to it.
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Create a Client Expenses form:
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Create a Clients form and link it to the above Client Expenses form:

Make sure you’ve selected One to Many as the Link Type.

A note about the Show Inverse Relationship option. You can enable the Show Inverse
Relationship option if you would like Tap Forms to manage both sides of the relationship for
you. Enabling the Show Inverse Relationship option will automatically create a Link From
Form field which will show you which parent record linked to the record you’re viewing. In
our example that means a Client Expense record will display a field that links back to the

*
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Now when you add or edit a record on your Client form, you can see the list of Client Expenses. Initially
there will be none, but you can click the + button above the list of Client Expense records to add one. By
adding a record from this view Tap Forms will link the new Client Expense record to the parent Client
record.

When you add a child record to the parent record form, Tap Forms will switch the display to the child form
(in this case Client Expenses) along with a back button which when clicked will return you to the parent
record from where you came.

Client form so for any selected Client Expense record, you’ll easily be able to see which
Client it belongs to.

Don’t create your own Link From Form field. Tap Forms will create it and set it up properly
for you when you enable the Show Inverse Relationship option.

!
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Many to Many

An example of a Many to Many link could be a list of team members who are assigned to projects for the
selected Client. A team member can work on multiple projects, so a many-to-many relationship makes
sense here. They may work on only one project at a time, but over time they may have worked on various
projects, so using a many-to-many relationship allows you to keep that historical information as you look
back through old projects.

Add a Team Members form that contains a list of people that work at your company. You could add their
name and job title.

Now add the linked form field to the original Clients form:
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Make sure you click on Many to Many for the Link Type and select the Team Members form from the Link
to Form property.

Now when you view your Client record the list of Team Members will initially be empty:
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After you’ve added some Team Members you’ll be able to select from the list of Team Members by
clicking on the checkmark button just below the linked field.

This will display a popover with a list of child records which haven’t yet been linked to your parent record.
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Select one or more records from the popover and then click the Select (#) button.

The list of linked records will update to show the records you’ve previously selected and the records you’ve
just selected.

And that’s the difference between a One to Many and a Many to Many Link to Form field.
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Join

The Join Link Type option allows you to join two forms together based on some criteria that’s common
between the parent and child forms. An example might be if you have an Orders form and an Order Items
form. The parent Orders form would typically have an Order Number field. The child Order Items form would
also have an Order Number field.

The Join Link Type can be used to make a connection between the Orders and the Order Items form by
matching the Order Number field from both forms. That means that for any Order record, Tap Forms will
display a list of Order Items that match the Order Number field in both the Order and Order Items forms.
Currently the matching criteria checks if the values of Text type fields are equal in a case insensitive way.
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Menu Commands
Tap Forms gives you the ability to perform a variety of commands on forms, records, and layouts. For
example, you can delete a form, duplicate a form, share a form template with others, and import a form
template you’ve been given by others. You can create new records, delete records, duplicate records.

File
The File menu contains a variety of commands for exchanging your data
with others. It contains commands for importing records, exporting records,
importing form templates, exporting form templates, importing Bento templates,
backing up your database, restoring your database and printing your forms. Other
topics in this guide will go through each of these options in detail.

View
The View menu lets you switch between different views. You can switch
between the All Forms and My Forms lists of forms and between the Single-
Column and Multi-Column records list views as well as the new Photo Grid, Map,
and Calendar views.

Forms
To delete a form, select a form and click the Forms menu. Then select the
Delete Form command.
When you delete a form, Tap Forms will delete all of the records and all of the
photos and files associated with the records in the form.

To duplicate a form, select a form and click the Forms menu. Then select
the Duplicate Form command.
When you duplicate a form, Tap Forms duplicates just the form template, not any
of the records. Custom layouts are also duplicated along with the form template.
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You can also access these commands by right-clicking on the selected form in the My Forms or All Forms
list.

Records
To delete a record, select a record and click the Records menu. Then select
the Delete Record command.
When you delete a record, Tap Forms will delete all of the photos and files
associated with the selected record.

To duplicate a record, select a record and click the Records menu. Then
select the Duplicate Record command.
When you duplicate a record, Tap Forms will duplicate all of the photos,
drawings, and audio recordings associated with the record. File Attachments will
not be duplicated at this time.

You can also access the Duplicate and Delete commands by right-clicking on the selected record.

Go To
You can use the keyboard to quickly navigate between records. Command-]
will move to the next record. Command-[ will move to the previous record.
Command-shift-[ will move to the first record. And command-shift-] will move to
the last record in your form.

After you’ve made a duplicate of your form, you will not see the default or custom layouts
displayed just yet. To see these views, press the + button on the records list view to create
a new record. Once a new record has been created in your form, the Default Layout and
any custom layouts that were in the original form will also be displayed.

*
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Layout
The layout menu provides a variety of commands for managing your custom
layouts. From here you can edit layouts, duplicate layouts, delete layouts and
perform a variety of commands on items in your custom layouts.

Tools
*The tools menu just gives you an alternate way of gaining access to the Pick
Lists and Categories Edit screens.

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 94 of 112



Barcodes
Tap Forms can now generate and print 24 different kinds of barcodes.

The following barcode symbologies are supported:

Coda bar Code 39 modulo 43 Facing Identification Mark Pharmacode One Track

Code 11 Code 93 Interleaved 2 of 5 POSTNET

Code 128 EAN 13 ISBN QR Code

Code 39 EAN 2 Supplement ISMN Standard 2 of 5

Code 39 Full ASCII EAN 5 Supplement ISSN UPC A

Code 39 Full ASCII modulo 43 EAN 8 MSI (Modified Plessey) UPC E

To configure your barcode:

1. Click on the Form button in the toolbar.
2. Click the Fields tab.
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3. Find the field you would like a barcode generated for and click on it.
4. Click on the Display as Barcode checkbox in the field’s properties pane down below.
5. Click on the Edit Barcode button.
6. Select a barcode symbology. You can enter sample text to see how it will look.

To display your barcode:

1. Follow the instructions in the Layout Designer topic to create a new custom layout.
2. Drag your barcode field into your custom layout.
3. Resize your barcode to fit the area required.

A great use of the new labels feature is to put a barcode onto a label and print them out to stick them on
anything you want barcodes on.

To print your barcodes:

1. Select the custom layout which contains your barcode.
2. Select the Print command from the File menu.
3. Click the Print button.
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If you’re printing just a single label on one page, select the Print selected records option. If you want to
print different barcodes for each label, select the Multiple records per page option for your label and then
select the *Print all records” option on the Print sheet.

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 97 of 112



Printing
Tap Forms has 4 different ways of printing your records:

1. Record Details with the Default Layout
2. Record Details with a Custom Layout
3. Table of records in a list format
4. Labels in a grid format

To print your data, click on the File menu and then click on the Print menu item.

1. Record Details with the Default Layout

The benefit of printing the Default Layout is that it’s quick to get a nice printed report of your record details.
Also, if a single record is quite long, Tap Forms will intelligently span the printout of the record across
multiple pages, avoiding cutting off the contents of an individual field across pages.

Initially when you display the Print sheet, it will appear with only the very basic print settings.

To see the advanced print settings, click on the Show Details button.

You can also use the Fields list to select which fields you would like to print or not print. Tap Forms will
make sure there are no gaps in the printout as you enable or disable different fields.
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The print sheet will expand to display many more options for printing, including a variety of Tap Forms
specific options.
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The top area of the print sheet contain standard print settings that are available in most apps. You can
select the printer, the number of copies, which pages to print, the paper size, and the paper orientation.

The bottom area contains options specific to Tap Forms.

Most of the options in the Tap Forms area are only relevant for printing the Default Layout and the Table of
records layout. They have no effect on printing custom layouts other than the following options:

1. Print selected records – to print just the records you’ve selected in the records list view.
2. Print all records – no matter how many records are selected.
3. Print field borders – to enable or disable printing of any borders around fields in your custom layout.

2. Record Details with a custom layout

There’s not much difference in the print sheet when you’re printing a custom layout.
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3. Table of records in a list format

If you need to print multiple records per page in a list format with headers and footers, then use this print
layout. Tap Forms will print as many columns as will fit on a single page width. You can change to
landscape orientation to get more room to print additional columns. You can also enable or disable different
fields to print on the list view.

Tap Zapp Software Inc. Tap Forms Mac - 5.0

Page 101 of 112



Most of the options on the print sheet will have some effect on the printout. For example, you can enable or
disable the printing of the form name, the date, the time, and choose whether or not you want alternating
light and dark row backgrounds for your records.

To adjust the widths of the columns for printing, click on the Fields tab on the Print panel,
double-click on each width, type in a new value, and press the Return key to accept the new
width. Tap Forms will remember the widths of the columns for the next time you print that
form.

*
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4. Labels in a grid format
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Preferences
To access various other settings for Tap Forms, click on the Tap Forms item in the menubar at the top of
the screen, then click on the Preferences menu command.

There are 4 preference panels to select from:

1. General
2. Lists
3. Security
4. Maintenance

General

There are 3 functions to perform on the General preferences panel:

1. Reset dialogue warnings. If you suppress warnings on any of the dialogues you may want to see them
again, so click this button.

2. Ruler Units. This is for the units displayed in the ruler on the Layout Designer view.
3. Backup & Restore. You can tell Tap Forms to backup when you quit the app and how many backups

to maintain, The Show Files button will also show you the backup files on your drive. You can also
provide a custom backup location.
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Lists

This is where you configure your Categories and Pick Lists. See the separate Categories and Pick Lists
topics for more on these.

Security

This is where you encrypt or decrypt the database, set the auto-lock option and set a lockout interval..
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Auto Lock tells Tap Forms to lock Tap Forms if you haven’t used it after a set number of minutes that you
can configure.

To encrypt the database, click on the Encrypt Database button. If your database is already encrypted, you
can decrypt it by clicking on the Decrypt Database button.

If you’ve forgotten your encryption key, launch the Keychain Access application on your
Mac, search for Tap Forms, then double-click on the Tap Forms application password entry.
Next, click on the Show password checkbox button. You’ll be asked to enter your
computer’s password then you’ll see your encryption key displayed. The Keychain Access
application can be found by typing Keychain Access into the Spotlight search field or by
launching it from the Utilities folder (which is inside your Applications folder) in the Finder.

*

If you’ve forgotten your encryption key and you don’t see it in the Keychain Access
application, there’s no way to recover your data. So make sure you never forget your
encryption key or you have a copy of it stored in another secure location.

!
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Maintenance

The Maintenance screen is where you can perform the following database maintenance task:

1. Compact Database. When you add forms and records to Tap Forms, the database file size will
increase. You would naturally think that if you deleted data, the size of the database file would
decrease. However, that’s not the case. When you delete data, the space used is simply marked as
available for new data. If you add a lot of data and then delete a lot of data, the file size can grow to
be quite large. If you do that enough, the database file size will much larger than it needs to be.
Compacting the database will compact it and give you a much smaller file. Smaller files also help to
increase the performance.
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Views
Tap Forms 5 has 5 different ways of viewing your information.

1. Single-Column List View
2. Multi-Column List View
3. Calendar View [New]
4. Map View [New]
5. Photo Grid View [New]

This topic will describe how to use the 3 new views.

Calendar View
Records with a date field can be viewed in calendar format. This allows you to attach receipts, travel
confirmation codes, and special event information to the calendar.

To view records in calendar mode:

1. Click the Calendar button in the toolbar at the top of the window or select Calendar View from the
View menu.
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2. To view the records arranged by a specific date field, select a field from the Arrange by pull-down
menu. If you don’t see any fields there, make sure you have at least one Date or Date & Time field in
your form.

3. Tap Forms will then display your records grouped together on the same day for the selected date
field.

4. To navigate through dates, use the previous and next arrows.
5. Click the Today button to quickly jump to the current month.
6. To navigate through months or years, use the calendar pop-up window:
7. Click the calendar button beside the displayed month and year at the top of the calendar view.

a. Use the inner set of arrows (black) to display the next or previous months within the same year.
b. Use the outer set of arrows (red) to display the same month in the next or previous years.

To filter the list of records for a specific date:

1. Click on the specific date.
2. To view the full list of records in the form, click the date again to deselect that day.
3. To view records for multiple dates, press the shift key while clicking on the desired date range.
4. To show or hide the records list, click on the arrow button in the upper right corner of the calendar.

Map View
Records with a location field can be viewed on a map.

To configure your records for plotting on the map:
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1. Select the Form you wish to plot on a map.
2. Click the Map button in the toolbar at the top of the window or choose the Map View” command from

the *View menu.
3. Click the Arrange by pull down menu to select which Location field you would like to plot on the map.

If you don’t see any fields listed, make sure you have at least one Location field in your form.

To add a pin to the map:

1. Click the Location field button on each record to display a map for that specific field.
2. Click the Locate Me button to pinpoint your current location or use the search function to search for a

location.
3. Click Save to save that location.

If you don’t see your location on the map right away, drag the map slightly to refresh the view.

Photo Grid View
Records with a photo field can be seen in a photo grid view.

To change the default pin colour for this database document go to Preferences.*
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To populate the photo field:

1. Click on the record.
2. Click Edit (if you’ve enabled the Edit/Save button in Preferences)
3. Click the appropriate button and perform one of the following:

a. Click the (+) button to select a file from disk.
b. Click the camera button to take a picture with the camera on your device.

4. To view records in Photo Grid View, click the grid button in the toolbar at the top of the window or
select Photo Grid View from the View menu.
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Note: If you don’t see your photos in the Photo Grid View, make sure you’ve selected the photo field from
the Arrange by pull-down menu.

Note: Hiding sections gives a cleaner view of the grid.

To hide or show section headings:

1. Click the Form button at the top of the records list.
2. Click Hide Sections, or click Show Sections.

Photos can optionally be resized in order to reduce the amount of disk space consumed. This can be done
all at once for a Photo field in your form.

To resize all your photos for a Photo field:

1. Select Form from the toolbar at the top of the window.
2. Under Fields, select a Photo type field from the list of fields.
3. Select a Photo Size from the pull-down list.
4. Use the up/down arrows to choose a level of Quality.
5. Click Resize All Photos.

You can also set the thumbnail size for a photo. This will affect the size of the photo displayed only on the
Single Column List view.
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